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Who Should Read This Guide?

Who Should Read This Guide?

This guide is for attendants who use the SUPERSET™ 7000 Attendant Console
and for technicians who install it.

What you need to know

As an attendant, you should have some experience using applications for
Windows-based PCs. Technicians should know how to install software on a PC.

Where You Can Find More Information

For attendants
SUPERSET 7000 Attendant Quick Start Guide (PN 9119-953-011-NA) -
describes the most frequently used SUPERSET 7000 call-handling procedures.

SUPERSET 7000 Attendant’s Quick Reference Guide (PN 9119-953-017-NA) -
provides a keystroke summary of all console functions.

SUPERSET 7000 Attendant Tutorial - (PN 9119-300-013-NA) — introduces the
SUPERSET 7000 to first-time users.

For technicians

SUPERSET 7000 Installation Guide (PN 9119-953-003-NA)- describes how to
install the Mitel PC TALK TO® card and software.

SX-200® System Practices (PN 9109-953-051-NA) - contains information on
installing and programming the SX-200.

Conventions Used in this Guide

This guide uses the following conventions to differentiate between the two types
of console keys:

¢ Fixed-function keys appear in bold letters—for example, Answer or Hold.

¢ Variable function keys (called Softkeys) appear in bold letters within
brackets—for example, [BELL ON] or [CONFERENCE].
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SUPERSET 7000 Application Package Components

SUPERSET 7000 Application Package Components

The SUPERSET 7000 Application Package consists of the following items:

¢
¢

*® & o o

One TALK TO BX card with installation instructions.
A 5%-inch and a 3'-inch floppy disk containing the application software.

A 3%-inch floppy disk containing a tutorial that introduces the
SUPERSET 7000 Attendant Console.

Two sets of keyboard overlays and decals. The overlay identifies the keys
used for call handling and fits around the keys on your keyboard. The decals
serve the same purpose but are applied directly to the keys.

One Mitel 400-series handset and cord.
SUPERSET 7000 Attendant Console User Guide
SUPERSET 7000 Attendant Console Quick Start Guide

SUPERSET 7000 Attendant Console Quick Reference Guide

~
Use only a Mitel-supplied 400-series handset and cord or optional headset with the
SUPERSET 7000 application.

What You Need to Run SUPERSET 7000

The SUPERSET 7000 application runs on a PC that meets the following
minimum requirements:

¢ 80486/66 MHz processor with 8MB of RAM and Windows™ 3.1. (A Pentium

processor with Windows 95 and 16MB of RAM are recommended.)

¢ VGA monitor

¢ 3 inch floppy drive

¢ An AT 101 enhanced keyboard

¢ An ISA slot for the TALK 70 card

A sound card is optional; having one allows you to adjust the console ringer
volume and cadence.

~

The SUPERSET 7000 application will not run under Windows NT™.




Installing the SUPERSET 7000

PABX Programming

The SUPERSET 7000 requires no special PABX programming. Program the
PABX as if the SUPERSET 7000 was a SUPERCONSOLE 1000® Attendant
Console.

Installing the TALK TO Card

The TALK TO card must be installed before the SUPERSET 7000 application
software. Refer to the documentation supplied with the card for installation
instructions.

Installing the SUPERSET 7000 Application Software

Perform the following procedure only if you are a qualified service technician.

To install the SUPERSET 7000 application software:

1 - Verify that Windows 3.1 or later is installed on the PC. If it is not installed,
install it before proceeding to the next step.

2 - Insert the SUPERSET 7000 disk in the floppy drive.

3 - From the Start menu (Windows 95) or the File menu or Program Manager
(Windows 3.1), choose the Run command.

4 - In the Run dialog box, type the floppy disk drive letter followed by :\setup
For example, if the drive letter is A, type A:\setup
5 - Click OK.

6 - Follow the on-screen instructions.

Be sure to check the Readme file installed with the application. It contains
information unavailable when the user guide was printed.

~
Make a backup copy of the application software and store it in a safe place. Use

the DOS Backup command or the Microsoft Backup utility (Windows 95 only) for
this. For more information, consult the documentation supplied with the PC.
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Introduction

Introduction

The SUPERSET 7000 is an attendant console application for Windows-based
PCs. It features a built-in telephone directory of system users and an intuitive
user interface for smooth, efficient call handling.

A note about feature availability

The features available on your telephone system have been selected by your
company and may not include all the features described in this guide.

Console Components

Your SUPERSET 7000 Attendant Console consists of a personal computer (PC)
with monitor and keyboard, keyboard labels, and a handset and cord.

The monitor displays call-handling prompts and call status information. Use the
keyboard for all call-handling activities, including dialing. Use the handset to
talk with callers.

CONSOLE MONITOR
The SUPERSET 7000 window is divided into four areas:

& The Status area at the top of the window displays the date and time, number
of calls waiting, the console bell (ringer) status, and the Day/NIght service
status of the console. It also displays alarms when a problem with the
system or console occurs.

& The Application area is divided into four sections: The top two sections
display information about calls on hold and a directory of extension users
in your organization. The bottom two areas indicate the “Source” (calling
party) and “Destination” (called party) of all calls handled by the console.

¢ The Command and Response area displays command prompts and system
messages.

& The Softkey area at the bottom of the screen displays the Softkey labels. The
labels correspond to the Function keys F1 to F10 on your keyboard. See the
next section for more information about the Softkeys.
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Softkey Area

CoNsOLE KEYBOARD

The SUPERSET 7000 keyboard is divided into logical groupings of keys that
allow quick access to attendant and PC functions.

¢

Dialpad keys - used to dial telephone numbers. (You must have Num Lock
on to use the dialpad.)

¢ Typing keys - used primarily to enter names when using the Phone Book.

¢ Cursor keys - moves the bar (cursor) that is used to highlight items on the

screen for selection or indicates where characters you type will appear.

Call-handling keys - fixed function keys that are used to manage calls and
include Page, Block, Hold, Cancel, Function, Retrieve, Release and Answer .

Softkeys - used to enter commands. The commands available change with
different stages of call processing. For example, if F8 is labeled Override,
pressing the eighth softkey lets you override a busy extension’s
conversation. At another time, the same key, F8, could be labeled Night 1.
Now, pressing F8 puts the console into night service.

¢ Volume Adjustment keys - used to increase or decrease the handset volume.

¢ Dial # key - used to dial the pound (#) symbol when necessary .
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CONSOLE HANDSET

The SUPERSET 7000 Attendant Console is equipped with a handset and cord. A
Mitel-approved headset is also available for use with the console.
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Starting and Closing the SUPERSET 7000
Application

To start the SUPERSET 7000 application:
1 - Start Windows.
2 - Do one of the following:

¢ On PCs with Windows 3.1, open the Program Manager, select the
SUPERSET 7000 group icon, and then double-click the
SUPERSET 7000 icon.

4 On PCs with Windows 95, click the Start button, point to Programs, and
then to SUPERSET 7000, and then click SUPERSET 7000.

To close the SUPERSET 7000 application:
Do one of the following:
4 On the File menu, click Exit.

¢ Double-click the control box in the upper-left corner of the SUPERSET 7000
application window.

10




Adjusting the Console

Adjusting the Console

RETURNING TO THE MAIN SCREEN

The main screen is displayed during most call-handling operations. When you
access an application such as Phone Book or an operation through the
Function key, you can return to the main screen in two ways: You can back up
through the previous screens or automatically return to the main screen with
one keystroke.

To return to the main screen:

Do one of the following:

¢ Press [BAckup] repeatedly to back up through the screens and return to the
main screen.

¢ Press [ExIT] to return to the main screen to cancel and re-execute an
operation.

ADJUSTING THE RINGER VOLUME AND CADENCE

If your PC has a sound card and the SUPERSET 7000 is configured to use it, you
can can adjust the volume and cadence of the ringer. Use the Options command
in the File menu to specify that you want to use the sound card.

To adjust the ringer volume while the console is ringing:

¢ Use the Volume Control supplied with the sound card.

To adjust the ringer cadence:
1 - Select Options from the File menu.

2 - Select a ringer cadence from the Warble list, and then click Test to hear
your selection.

3 - Select OK.

You must restart Windows before the new ringer cadence will take effect.

1
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ADJUSTING THE HANDSET VOLUME

You can increase or decrease the audio level of the handset during a call. When
you end the call, the volume returns to a default level.

To adjust the handset volume:

¢ Press the [-] key repeatedly to lower the volume or the [+] key to increase it.

TURNING THE CONSOLE BELL (RINGER) OFF/ON

When the bell is off, the C/W indicator in the Status area is the only indication
that calls are waiting to be answered.

To turn the bell on or off:
1 - Press Function.

2 - Press [BELL OFF] or [BELL ON].

SWITCHING TO NIGHT/DAY SERVICE

12

Incoming calls that normally ring the console during the day can ring another
answering point at night. Your system may have one or two night service modes
called Night 1 and Night 2. The mode you should select depends on system
programming.

Any attendant can switch the system into night or day service. When the system
is in night service, the night status indicator (Night 1 or Night 2) displays on all
consoles.

To switch to night or day service:

1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [CHG SERVICE].

4 - Press [NIGHT 1], [NIGHT 2], or [DAY SERVICE] as required.
5 - Press [ExiT].

You can change the Night 1 and Night 2 answering points for individual trunks
from the console. For more information, see Setting up Night Answer Points on
page 45.
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SETTING THE CONSOLE LANGUAGE

You can display the call-handling information and softkey prompts in English,
French or Spanish.

To change languages:
1 - Press Function.
2 - Press [LANGUAGE].

3 - Press the softkey that corresponds to the language you want.

ATTENDANT CONSOLE LocKkouT

You can enter an access code to restrict the capabilities of the attendant console.
This prevents system tampering via the console when you leave it unattended—
for example, during breaks. When the console is locked out, it cannot be used
to place outgoing trunk calls or to access console functions, except 911 Call
alarms. You can still use the console to place internal calls and to answer
incoming trunk calls.

To lock out the console (cannot have calls connected):

¢ Enter the console Lockout access code. (Ask your communications
department for the code.)

The screen displays “Console in Restricted Service.”

To return the console to normal operation:

¢ Re-enter the console Lockout access code.

13
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UsING AuTO ANSWER

When Auto Answer is on, you can automatically answer new calls by releasing
the previous call. The Status area on the console screen indicates whether Auto
Answer is on or off.

To turn Auto Answer on or gff:

4 Select Options on the Configure menu, and then click Auto Answer.

To use Auto Answer:

¢ Press Release to automatically answer the next incoming call.

To bypass Auto Answer:

¢ Press Cancel to avoid automatically answering the next incoming call.

You cannot bypass Auto Answer when transferring calls. To transfer a call, you
must press Release; pressing Cancel will not transfer the call.

Pressing Release when calls are waiting answers the call that has been in the
queue longest.

RECONFIGURING THE CONSOLE

14

You can change the options selected during the installation of the

SUPERSET 7000 application at any time. These options allow you to specify a
different IRQ setting and keyboard type and to enable or disable features such as
Auto Answer.

To reconfigure the console:

1 - Choose Options from the Configure menu.

2 - Make the required changes to the settings. (See the online Help for
information about the settings. To locate the information, click the Search
button in the Help window, and then type Configure.)

3 - Choose OK to save the changes.
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Call-Handling Keys

Call-Handling Keys

The call-handling keys consist of eight fixed-function keys and the dialpad
keys. A template that indicates the location of the call-handling keys is provided
with your SUPERSET 7000 application. You may also use the supplied decals
and apply the key names directly to the keys.

~
The forward slash [/] key on the dialpad is used to dial pound (#). You must have
Num Lock on to use the dialpad.
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Call Handling

Answering Calls

18

Ringing and a ¢/W indicator in the upper-right corner of the screen signal the
arrival of a call. The number next to the C/W indicator tells you how many calls
are waiting to be answered.

The information displayed next to the softkey prompts F1 to F10 indicate the
actions you can take by pressing the corresponding softkey.

For example, you can answer an outside (trunk) call by pressing [Lpn 1] (Listed
Directory Number 1), or an internal (extension) call by pressing [DiaL O].

The following softkey prompts can accompany an incoming call:

[RECALL]
[INTERNAL]
[D1AL O]
[PrIORITY O]
[NIGHT ANS]

[Lon 1], [LDN 2], . . . [LDN 9]

*® & 6 &6 O o o

or any pre-programmed customer-specific information (for example, your
company may choose to display [LINE 1] instead of [LbN 1]).

The [INTERNAL] prompt indicates calls to a specific attendant made by dialing
the console’s internal directory number (as opposed to dialing “0™). The other
prompts are explained elsewhere in the guide.

To answer calls:

Do one of the following:

4 Press Answer to answer the first call in the queue.

# Press a softkey (F1 — F10) to answer a specific type of call.

The SOURCE area on the screen shows the extension number and name for an
internal call, or a trunk number for an external call.

The DESTINATION area remains blank until you dial a destination number.




Answering Calls

New CALL INDICATION

When you are engaged in a call, a single burst of ringing signals the next
incoming call. Subsequent calls do not ring the console, but the C/W indicator
on the screen tells you have additional calls waiting.

~
The console can be programmed to provide a single burst of ringing at regular
intervals when calls are waiting.

WHEN MuLTIPLE CALLS ARE WAITING

You cannot answer a new call until the one you are engaged in is transferred,
disconnected, or put on hold.

19



Call Handling

Extending (Transferring) Calls

When a caller requests to speak to someone, ask the caller to wait a moment,
and then transfer the call to the requested destination.

~
The forward slash [/] key on the dialpad is used to dial pound (#). You must have
Num Lock on to use the dialpad.

To transfer a call:

1 - Dial the destination number using the dialpad keys.

The caller is automatically placed on hold while you complete the transfer.
2 - When you hear ringing, press Release to connect the caller to the
destination and release the console from the call.
MisDIALED NUMBERS
If you do not want to complete dialing, or if you misdial a number, either

¢ Press the — key to erase the misdialed digits, and then dial the
correct number.

- Or-

4 Press Cancel to return to the Source party, and then redial the number.

20




Extending (Transferring) Calls

REACHING A Busy DESTINATION OR AN EXTENSION
WITH Do NoT DISTURB ACTIVATED

If the called destination is busy or the extension has Do Not Disturb activated,
the DESTINATION area on the screen will show “Busy” or “DND.”

In both cases, your options for handling the call are the same, except for the
Callback option, which only applies when calling a busy destination.

To handle a call to a busy destination or an extension with
Do Not Disturb activated:

4 Press [SOURCE] to return to the caller requesting the transfer.
¢ Press Cancel to disconnect the destination so that you can dial a new one.

¢ Press Release to camp the caller on to the busy destination or disconnect
the Source. (For an explanation of camp-on, see page 86.) If the transfer is
not allowed, you will hear a beep tone and “CANT” will display on the
console screen.

4 Press [OVERRIDE] to break into the busy extension. For more information on
using Override, see page 29.

4 Press [SEND Msq] to send a message waiting indication to the called
extension. For more information on Message Waiting, see page 29.

¢ Press [CALLBACK] to receive notification when the destination is free.

If you reach a busy extension or you are placing an outside call and all of the
trunks are busy, you can request an automatic Callback. The system monitors
the line and rings the console when the line becomes free. When you answer a
Callback at the console, the SOURCE area on the screen will show “CALLBACK.”
Callbacks on outside calls are used when all system trunks are busy, not when
the called party is busy.

21




Call Handling

REACHING AN EXTENSION WITH AN ADVISORY MESSAGE

Users with a SUPERSET display phone can show a short message, called an
Advisory Message, on other display phones or consoles that call their phone.
When you call an extension with an Advisory Message, the message appears in
the DESTINATION area on the screen as follows:

3070 S.BERRY IN A MEETING RINGING

In this example, the user has left the message “In a meeting” on his or her
phone. For a list of other Advisory messages, see page 85. See also Setting/
Clearing Advisory Messages on page 54.

Placing Calls

To place a call:

1 - Dial the destination number using the dialpad keys.

The dialed number appears in the DESTINATION area on the screen.

2 - After you complete the call, press Release to disconnect it from the console.

~
The forward slash [/] key on the dialpad is used to dial pound (#). You must have
Num Lock on to use the dialpad.

22




Placing a Call on Hold

Placing a Call on Hold

You can place up to six calls on hold. The On Hold area on the screen shows the
Hold slot number (1-6), the name of the caller (internal calls only) and the
extension or trunk number.

To place a call on hold:

1 - Inform the caller that you are placing the call on hold.

2 - Press Hold.

To retrieve a call on hold:
1 - Press Retrieve.
2 - Do one of the following:
* Press the Hold slot number (1-6) of call you want to retrieve.

* Press Retrieve again to retrieve the longest-held call.

23



Call Handling

HoLbD REcALL

If a call is left on hold longer than a specified time, it returns to the console as a
recall. The console beeps and the Hold slot number on the screen flashes to indicate
the recall.

To answer the recall, follow the procedure above for retrieving a call on hold.

HoLb Pickup

Extensions can pick up calls placed on hold at the console by dialing a Hold
Pickup code and the hold location. The call and the code required to retrieve it
are usually announced using paging. For more information, see page 27.

STACKED HoLD

When an extension has a call on hold or is in a conference call and dials the
attendant, the SOURCE area on screen will indicate a held or conferenced call.
For example, a held call would show as:

Pressing [ConF] establishes a conference call involving the console and
extensions 3456 and 3056.

24




Setting up Conferences and Call Splitting

Setting up Conferences and Call Splitting

When you are setting up a call between two parties, you may want to conference
the call (speak with both parties at the same time). Once you establish the
conference, you can speak privately to either party by splitting the conference.

To conference a call:

1 - Start with a call involving one of the parties you want to include in the
conference.

2 - Call the other party.

3 - Press [CONF].

To split a conference call:

4 Press [SOURCE] to speak privately to the first party or [DEST] to speak
privately to the other party.

To release the console_from a conference call:
Do one of the following:

¢ Press Release to connect both parties together and then release them from
the console.

¢ Press Cancel to release the parties from the console without first
connecting them.
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Answering Recalls

26

When a call is transferred and the extension is busy or does not answer, the call
returns to the console within a specified time or is directed to the extension’s
voice mailbox (if available).
To answer a “No Answer” recall:
1 - Press Answer or [RECALL].
2 - Inform the caller that the destination is not answering.
3 - Do one of the following:
¢ Press [RING AGaIN] to redial the same destination.
¢ Dial a new destination, and then press Release.

¢ Press Cancel to disconnect the Source party.

To answer a “Busy” recall:
1 - Press Answer or [RECALL].
2 - Inform the caller that the destination is busy.
3 - Do one of the following:
¢ Press Cancel to disconnect the Source party.
¢ Press Release to transfer the call to the same destination again.
¢ Press [DEST] to reconnect with the busy destination.
4 - 1If you pressed [DEsT], do one of the following:
¢ Press [OVERRIDE] to break into the busy extension.

¢ Press [SEND MsG] to send a message waiting indication to the busy
extension.

4 Press [SOURCE] to connect to the source party.
¢ Press [CALLBACK] to be notified when the extension is free.

¢ Press Release to camp the Source on to the destination again. (See page
86 for an explanation of camp-on.)

¢ Press Cancel to clear the destination and dial a new extension number.




Answering Intercepts to the Console

Answering Intercepts to the Console

Misdialed calls from extensions, or calls to extensions with Do Not Disturb
activated, could ring the console depending on system programming. When you
answer the call, the screen will show the reason for the interception:

¢ DND INT for calls to an extension with Do Not Disturb activated.
¢ ILL # INT for illegal number dialed.
¢ VAC # INT for vacant (unassigned) number dialed.

Paging from the Console

Two types of paging are available from the console: Public Address (PA) Paging
and Extension Paging.

PA PAGING

If your system has external paging equipment, you can place a call on hold and
then page for someone to pick up the call from the console Hold slots. You can
also use PA Paging to make public announcements.

Your paging equipment may be set up to access several areas or “zones.” If so, you
use the Page key to speak to all zones at once and access codes to speak to
individual zones. These codes are available from your communications department.

To page someone to pick up a call on hold at the console:

1 - Place the Source call on hold. (See page 23.)
2 - Press and hold Page.
3 - Do one of the following:

¢ If you have only one paging zone, announce the Hold Pickup access code
and the highlighted Hold slot number.

¢ If you have more than one page zone, dial the two-digit paging code (dial
00 for all zones), and then announce the Hold Pickup access code and the
Hold slot number.

¢ If the paging equipment is already in use, you can press [OVERRIDE] to
interrupt the page in progress.

4 - Release Page.
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EXTENSION PAGING

Extension Paging allows you to page extension users using their telephone
speakers. This feature is available only for paging SUPERSET telephones that
are programmed as key system telephones.

You can use Extension Paging to page a specific extension (Directed Page), multiple
extensions assigned to a group (Group Page), or all extensions (All Set Page).
To page an extension:
1 - Press Set Page.
2 - Do one of the following:
¢ To page a specific extension, dial the extension number.

4 To page a group of extensions, press [GROUP PAGE], and then press the
two-digit group number.

¢ To page all extensions, press [ALL SET PAGE].

3 - Make the page.

Setting and Canceling Do Not Disturb
on an Extension

28

Do Not Disturb (DND) prevents calls from ringing a user’s extension. You can
set and cancel DND on a user’s extension while you are on a call with the user.
To set or cancel DND on an extension:

1 - While connected to the extension, press [No DiSTB].

“DND” appears next to the extension information on the screen to indicate
that Do Not Disturb is set.

2 - Press Release.

You can also set and cancel DND without calling the extension. For more
information, see page 52.




Setting and Canceling Message Waiting on an Extension

Setting and Canceling Message Waiting
on an Extension

If an extension is busy or the user does not answer, you can send a notice to let
the user know a message is waiting at the console. You can also cancel
messages you left at an extension.

To set or cancel Message Waiting on a ringing or busy extension:

1 - Press [SEND MsG] to set Message Waiting or [CLEAR MsG] to clear it.

“MSW"” appears next to the extension information on the screen to indicate
that Message Waiting is set.

2 - Press Release.

If you are setting Message Waiting on a SUPERSET display telephone, an
indication appears on the display to let the user know a message is waiting at
the console. On other types of telephones, either a flashing lamp or distinctive
ringing every 20 minutes indicates that a message is waiting.

Overriding Busy or Do Not Disturb

The Override feature allows you to intrude into a busy extension or an extension
with Do Not Disturb (DND) active.

To use Override:
1 - Press and hold [OVERRIDE].

If you are overriding a busy extension, both parties hear a long beep, and
then you enter the conversation. You will remain connected to the
conversation until you release the [OVERRIDE] softkey.

If you are overriding an extension with (DND) active, you will hear ringing.
2 - Press Cancel or Release to disconnect the console from the busy extension.

If the busy extension hangs up while you are pressing [OVERRIDE], you will
hear fast busy tone and the screen will show “Hung Up” instead of “Busy.”
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Using the Phone Book

30

The Phone Book allows you to find and call an extension user by typing the
user’s name or a portion of it.

To use Phonebook to look up an extension user:

1 - Press Phone Book.

2 - Type the person’s name or a portion of it (the portion must include
the first letter).

If the name is not unique, use the t or | keys to scroll through the list
until you have highlighted the one you want.

3 - Press [LoOKUP].

The name(s) display in the Phone Book area.

To increase the size of the Phone Book area (and display more information),
press [CHANGE SIZE].

4 - To the call the selected extension user, press [CALL].

5 - Press [EXIT].




Using Redial

Using Redial

You can redial the last manually dialed number (internal or external) by
pressing a single key.

To redial the last number:

¢ Press [REDIAL].

Setting up Serial Calls

The Serial Call feature allows outside callers to talk to more than one extension
user in sequence without redialing the main business number each time.

To set up a serial call while connected to an outside call:

1 - Tell the caller to remain on the line after completing each call.

2 - Press [SERIAL CALL].

“SER” displays in the Source area on the screen to indicate a serial call is
being set up.

3 - Dial an extension number.
4 - Press Release.

When the extension user hangs up, the outside call returns to the
console as a recall.

5 - When the call returns to the console, press [RECALL].
6 - Dial the next extension number, and then press Release.

7 - When all calls are completed, press [SERIAL CALL] and then Release.
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Using Tone Signaling

You may have noticed that when you dial a number at the console, you do not
hear any of the tones or pulses normally associated with telephones. This is
because the console “communicates” with the rest of the telephone system
using a different type of signaling.

However, there are times when telephone equipment, either in or outside your
office, needs to receive tones to complete a call. Typically, special services such
as Voice mail systems (described on page 35) require information in the form of
tones before allowing access.

To enable tone signaling while connected to a service requiring tones:

1 - Press [TONES ON].

2 - Dial the required code.

3 - When you complete the call, press [ToNEs OFF] to turn off tone signaling.

Flashing on Trunks

32

A trunk flash is a signal sent to another telephone system to do something such
as place a call on hold. You may need to use this feature when you have a call
from another PABX in your own company network, and you want to transfer it
to the originating PABX or to a third one.

You can flash only when you are talking on a trunk to another trunk in a
two-party call.

To flash on a trunk for further dialing:

1 - Press [FLASH].

2 - Dial the required number.

3 - Press Release.




Answering a Call with Night Service Enabled

Answering a Call with Night Service Enabled

When the console is in Night Service, incoming calls ring night bells or some
other night answering point. These calls can still be answered from the console
even though they do not ring the console bell.

The night answer point is programmed at the system level. If required, you can
change the night answering point for individual trunks from the console. For
more information, see page 45.

To answer a call when the console is in Night Service:

4 Press [NIGHT BELL].

Using Directed Call Pickup

Directed Call Pickup allows you to answer a call ringing at an extension. You
can also use this feature to retrieve a call that you transferred to the wrong
extension.

To pick up a call ringing at an extension:

1 - Dial the Directed Call Pickup code. (Your communications department can
provide the code.)

2 - Dial the extension number of the ringing extension.

3 - Speak to the calling party.
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Multiple Console Operation

When more than one console is in use at the same time, they will operate in one
of two ways:

1 - Independent Operation

Consoles in this arrangement operate independently. Each console has
unique hold slots and incoming calls ring a specific console. A recall to the
attendant returns only to the console that initially handled the call.

2 - Transparent Operation

With transparent operation, all consoles operate the same way. Recalls
return to all consoles, not just the console that originally handled the call.

The consoles are also given privileges to read or cancel messages left at an
extension by other extension users or the attendant. For more information
about reading and canceling messages, see page 53.

INTER-CONSOLE CALLS AND TRANSFERS

An attendant can make and transfer calls to another attendant by dialing the
console’s directory number, but not by dialing 0 (zero). Whether you are
transferring calls to an extension or another attendant, the procedure is the
same—see page 20 for instructions.

~
Inter-console calls cannot be put on hold.

CENTRALIZED ATTENDANT SERVICE (CAS)

CAS allows an attendant at one PABX to answer calls that arrive at another
interconnected PABX. Except for recalls, CAS has no effect on the way you
handle calls from the console. When a call from another PABX in a CAS system
recalls the console, it appears as a “Dial 0" call. Keep this in mind when
answering the recall as it may affect how you greet the caller.
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Voice mail

Voice mail

A voice mail system connected to your telephone system does not affect the
operation of the console. If a call is answered by such a system, you may be
prompted to enter an access code or an identification number. Before responding
to the prompt, you must turn on tone signaling using the [ToNES ON] softkey. For
more information, see Using Tone Signaling on page 32.
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Viewing System Alarm Information

Viewing System Alarm Information

An alarm indicator on the screen means a fault in the telephone system has
occurred. You can read information about the nature and location of the fault
from the console.

To read an alarm message:
1 - Press Function.

2 - Press [ALARM]. The screen shows, for example:
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3 - Record all the alarm information.

Press [MORE...] to display additional information or other alarms. The Alarm
indicator will continue to flash until all alarm messages have been display.

4 - Contact your communications department.
5 - Press [ExiT].

The system may be programmed to raise an alarm when an extension is left off-
hook without a call too long. If so programmed, the console will ring with no
calls waiting. To cancel the alarm and stop the ringing, press Function followed
by [Snow Lockour], and then press [CLEAR].
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Viewing 911 Call Alarms

40

This feature raises an alarm at the console when an extension user places a 911
call and identifies the extension that placed the call. With this information, you
can direct emergency services (for example, police or ambulance personnel) to
the location from which the call was placed. When a 911 Call alarm is raised,

the console rings and the screen shows,

“911 Call <Press FUNCTION Key for Details> ALARM".

A Hitdidiggin 191 {ocon
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To read a 911 Emergency Call alarm message:

1 - Press Function.

2 - Press [Am1 ], and then [S& 911].

3 - Record the number of the extension from which the 911 call originated.

If additional 911 calls were made, press [MORE...] to view them. To delete
the 911 alarm, press [CBR ].

4 - Contact the appropriate emergency services.
5 - Press [EXit].

If an attendant console is in Attendant Console Lockout state, you can still
access 911 alarm information, but you cannot clear the alarms.




Setting System Date and Time

Setting System Date and Time

You can change the date and time appearing on the console screen. The time
displays either in 12- or 24-format depending on system programming.

To set the time:

1 - Press Function.

2 - Press [Att Function].

3 - Press [Set Time].

4 - Enter the current time using four digits (hh:mm).

For example, for 9:30 enter 0930.

5 - Press [PM] if applicable.

[PM] appears only if the system is set to 12-hour format, and the hour
entered is in the range 01 — 12.

6 - Press [Set].

[Set] appears only if the time has been entered correctly. You can use the
key to make corrections.

To set the date:

1 - Press Function.

2 - Press [Att Function].

3 - Press [Set Date].

4 - Enter the current date in day/month/year format.

For example, for December 12, 1999, enter 121299,

5 - Press [Set].
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Canceling All Call Forwarding

You can cancel Call Forwarding on all extensions in the system.

To cancel Call Forwarding on all extensions:
1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [MORE...].

4 - Press [CAN. ALL Fwp].

You can also set up Call Forwarding for individual extensions from the console.
For more information, see page 51.

Canceling All Callbacks

You can cancel Callback messages on all extensions in the system.

To cancel Callbacks on all extensions:
1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [MORE...].

4 - Press [CAN. ALL CBK].
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Changing DISA Codes

You can change the DISA (Direct Inward System Access) code that outside callers
must dial to access system features.
To change the DISA access code:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [MORE...].
4 - Press [DisA CODE].
5 - Enter the new access code.
6 - Do one of the following
4 Press [SET] to confirm the new access code.

¢ Press [ExiT] to exit without changing the code.
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Setting up System-Abbreviated
Dialing Numbers

a4

Abbreviated dialing allows extension users to call a telephone number or enter
a system access code by dialing a three-digit index number. You can program
and display system-abbreviated dialing numbers from the console.
To program or display system-abbreviated dialing numbers:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [ABBR Di1AL].
4 - Enter a three-digit index number from 000 to 999.
Press « to delete entry errors and then enter the correct number.
5 - Press [PRIVATE] to not display the number when dialed.
6 - Press [ENTER].
7 - Press [CANCEL] to change the existing number.

8 - Enter the new number. (Include the outside line access code (e.g. “9") and
an area code, if applicable.)

You can insert pauses in the numbers. Enter *9 for each 1-second pause;
enter *1 for each 5-second pause.

Press « to delete entry errors, and then enter the correct number.
9 - Press [SET].

10 -Repeat step 4 to 9 to program other numbers, or press [EX1T] to end
programming.




Setting up Night Answer Points

Setting up Night Answer Points

A night answer point is the number of an extension or other destination where
incoming trunk calls will ring when the system is in Night Service. For more
information about Night Service, see page 12.

To set up night answer points:

1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [MORE...].

4 - Press [FLEX NIGHT].

5 - Enter the trunk number.

6 - Press either [NIGHT 1] or [NIGHT 2] to choose the night service mode.

7 - Dial the destination number of the night answer point.

The destination can be a telephone, an attendant console directory number,
an LDN number on a console, a hunt group or a Night Bell directory number.

8 - Do one of the following:

# Press [SET] to confirm the new number.

¢ Press [Exrr] to exit without making changes.
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Displaying the System Identification

A System Identification Number may be assigned to your PABX. This number
appears on Station Message Detail Reporting (SMDR) and traffic-measurement
reports to identify your system when central polling equipment is used. It is
usually unnecessary to change this number once it is entered.

To display or change the System Identification:

1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [SYSTEM IDENT].

4 - Enter a new three-digit number if required.

5 - Press [SET] to confirm the new number.

Displaying the Console Identity

46

The console has an extension number which extension users can dial instead of
"0" (zero), to call you. You can display the console extension number along with
system software version.

To display the console extension number and the system
software version:

1 - Press Function.

2 - Press [IDENTITY].




Accessing Applications

Accessing Applications

The Application function is primarily used by maintenance personnel or
someone responsible for doing Customer Data Entry (CDE). Access to these
functions requires a password.

To access the Application_function:

1 - Press Function.

2 - Press [MAINTENANCE] or [CDE].

Your Communications Department will give you further instructions if you are
required to do any Customer Data Entry.
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Setting/Canceling Call Forwarding

Setting/Canceling Call Forwarding

You can set up and cancel Call Forwarding on individual extensions from
the console.

The instructions that follow apply to systems programmed with Split Call
Forwarding, which allows you to specify different destinations for internal and
external calls. If your system is programmed with another type of Call
Forwarding, internal and external calls will both go to the same destination.
Note that calls from the console are considered external.

To set or cancel Call Forwarding on an extension:

1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [STATIONS].

4 - Dial the number of the extension for which you want to set or cancel
Call Forwarding.

If you dial an invalid number, press [CLEAR No.].
5 - Press [CALL Fwp].
6 - Do one of the following:
¢ Press [INTERNAL] to set or cancel call forwarding of internal calls.
¢ Press [EXTERNAL] to set or cancel call forwarding of external calls.
7 - Do one of the following:
# Press [CANCEL] to cancel the current call forwarding.

¢ Dial a destination and then select the type of call fowarding—Always, No
Answer, etc.

To return to the main screen without making changes, press [EXiT].
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Setting/Canceling Do Not Disturb

52

Do Not Disturb (DND) prevents calls from ringing an extension. You can set and
cancel DND on any extension in the system.
To set or cancel DND on an extension:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [STATIONS].
4 - Dial the extension number.
5 - Press [No DISTB].
The screen shows “DND” to indicate that DND is set.

You can also set and cancel DND while on a call to an extension. For more
information, see page 28.




Setting/Clearing Message Waiting

Setting/Clearing Message Waiting

You can notify extension users that a message is waiting for them at the
console. When the user returns and calls the console, “MSW" displays on the
screen to indicate that there is a message waiting for that extension.

Use this feature if you know that the person you are trying to contact is out of
the office. If you know that the person is in the office, use the Callback feature
described on page 21.
To set or clear Message Waiting on an extension:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [STATIONS].
4 - Dial the extension number.
5 - Do one of the following:
4 Press [SEND MsG] to set message waiting.
¢ Press [CLEAR MsG] to clear message waiting.

6 - Press [EXIT].

READING AND CLEARING MESSAGES
Depending on your system’s programming, you may be able to read and clear
messages left for an extension by another user or attendant console. Without
this capability, you can only read and clear messages that you have set.
To read and cancel an extension’s messages:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [STATIONS].

4 - Dial the extension number.
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5 - Press [READ MsG].

The absence [READ MsG] on the screen means that you are not authorized
to read or clear messages other than those you have left.

The screen shows the number of messages at that extension, the extension
number of the user that left the message, and when the message was left.

6 - Do one of the following:
¢ Press [NEXT MsG] to read the extension’s next message.
¢ Press [CLEAR MsG] to clear the message.

4 Press [Exrr] to return to the main screen.

Setting and Clearing Advisory Messages

54

You can read Advisory Messages left on a SUPERSET display telephone and
clear or change an existing message.

To read, set, or clear an Advisory Message:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Dial the extension number.
4 - Press [SET UP MsG].
5 - Do one of the following:
¢ Press [ON] to activate the currently displayed message.

¢ Press [NExt] until the message you want to leave appears, and then press
[ON] to activate the message.

If the extension has an Advisory Message active, the message will appear on
your screen. You can either press [OFF] to clear the message or replace it with
another one by pressing [NExt] until the replacement message appears, and
then pressing [ON] to activate the message.




Taking an Extension Out of Service

Taking an Extension Out of Service

You can take an extension out of service (busy it out) if there is a problem with
that extension or the system. An out-of-service extension can neither make nor
receive calls.

To busy out an extension:

1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [STATIONS].

4 - Dial the extension number.

5 - Press [Busy OuT].

If the screen shows “BUSY” instead of “IDLE” the extension is in use and
will not be taken out of service until it becomes idle.

6 - Do one of the following:

¢ Press [SET] to busy out the extension.

¢ Press [CLEAR] to return the extension to service.
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Viewing Trunk Status

Viewing Trunk Status

You can view trunk status information to determine the current assignment of
services and features on a trunk.

To view the current status of a trunk:

1 - Press Function.

2 - Press [ATT FUNCTION].

3 - Press [TRUNKS].

4 - Enter the trunk number.

5 - Press [StaTus] to view information about the trunk such as its Class of
Service (COS) and Class of Restriction (COR).

6 - Press [EXIT].
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Viewing Trunk Group Busy Status

You can check the status of trunk groups to see which ones are busy. A

maximum of 20 groups can be displayed at one time, either when the console
is idle or during call handling.

To check the status of trunk groups:

1 - Press Trunk Status to view the first 20 trunk groups.

The screen shows, for example:

In this example, trunk groups 02, 05, 07 and 12 are busy.
2 - Press [MORE...] to display the next 20 groups.
Repeat as required.

3 - Press [EXIT].
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Accessing Specific Trunks

Accessing Specific Trunks

You can access a specific trunk and use it to make an outgoing call.

To access a specific trunk:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [TRUNKS].
4 - Enter the trunk number.
5 - Press [ENTER].
6 - Press [ATT ACCESS].
7 - Do one of the following:
¢ If the trunk is free (as indicated by dial tone), dial the outside number.

¢ Ifthe trunk is busy, either press [FORCED RLs] to clear the trunk of the call,
or press and hold down [OVERRIDE] to barge into the call. Both parties will
hear a long beep before you enter the conversation.

Trunks that are designated as dictation trunks (M/MM leads), and in use, cannot
be accessed.
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Taking Trunks Out of Service

62

If may be necessary to take a trunk out of service (busy it out) if there are
problems with that trunk or the system. You can busy out an idle trunk or one
that is in use. Afterwards, you can return the trunk to service.
To busy out a trunk or return a trunk to service:
1 - Press Function.
2 - Press [ATT FUNCTION].
3 - Press [TRUNKS].
4 - Enter the trunk number.
5 - Press [Busy OuT].
6 - Do one of the following:
¢ Press [SET] to busy out the trunk.

4 Press [CLEAR] to return the trunk to service.
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Displaying and Changing Room Data

Displaying and Changing Room Data

Room data includes occupancy and condition status (Vacant, Clean, Outgoing
Call Restrictions, etc.) and the status of message waiting, wake-up call, and
other services. You can change room data while the console is idle, or when you
are connected to the room.

To display or change data_for a room:

1 - Press Function.

2 - Press [GUEST Room].

3 - Dial a room number (not necessary if you are already connected to the room).

The screen shows, for example:
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In this example, room 2702 is occupied and clean, and allowed to make
internal calls only.
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Hotel/Motel Features

66

4 - Do any of the following:

¢
¢

Press [CLR REG] to clear the message register count. (See page page 71.)
Press [No DisTB] to set Do Not Disturb and block incoming calls.

Press [SEND MsG] to set or [CLEAR MsG] to clear the message waiting
indicator on the room phone.

Press [SET WAKE-UP] to set or [CLR WAKE-UP] to clear a wake-up call
time. (See page 69.)

Press [StaTus] to change the room’s Occupany or Condition status (See
Changing Room Occupancy and Condition Status on page 68.)

Press [Room NUMBER] to display the status of another room. (This option
is not available when the console is connected to a room.)




Listing/Counting Rooms by Occupancy and Condition Status

Listing/Counting Rooms by Occupancy and
Condition Status

You can display a list of rooms by occupancy and condition status—for
example, Vacant and Not Clean, or Occupied and Maid Present. The system also
reports the total number of rooms that are in the state you specify. You can cycle
through all rooms or start with a particular room number—for instance, the first
room on the third floor.

To list all rooms by occupancy and condition status:
1 - Press Function.

2 - Press [GUEST Room].

3 - Press the softkey that corresponds to the rooms you want to display—for
example, to display all vacant and clean rooms, press [VAC/CLEAN RM].

—Source ~Dercinesicn
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4 - Press [MORE...] to display the next 10 rooms matching the specified states.

If a printer is attached to the console, you can print a list of all vacant or
occupied rooms. For more information, see Printing Reports on page 72.
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To display a list of rooms beginning with a particular room number:
1 - Complete steps 1 to 4 above.
2 - Press [ROoM NUMBER].

3 - Dial the number of the first of the rooms you want to display.

Changing Room Occupancy and Condition Status

You can change the occupancy and condition status of a room while the console
is idle or while you are connected to the room.

The occupancy and condition states are as follows:

Occupancy Condition

Vacant Clean
Occupied Dirty
Reserved Maid
Guaranteed To Inspect

out of Service

To change a room’s occupancy and condition status:
1 - Press Function.
2 - Press [GUEST RooMm].

3 - Dial the room number (not necessary if you are already connected
to the room).

4 - Press [STATUS].

5 - Press the softkey that corresponds to the states you want to set—for
example, to change a room from vacant to occupied press [OCCUPIED].

~
The Maid status can only be changed_from the room by dialing a code.

Your system may be programmed to automatically change all “occupied and
clean” rooms to “occupied and dirty” at a set time. Ask your communications
department_for information.
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Setting and Canceling Wake-up Calls

Setting and Canceling Wake-up Calls

Both the attendant and guest can set, change, and cancel wake-up calls for the
guest room. The system does not distinguish whether a wake-up call is set,
changed, or canceled from the attendant console or guest room telephone. So,
for example, a guest can cancel a wake-up call that was set by the attendant
and vice-versa.

You can set or cancel a wake-up call while the console is idle or while connected
to the guest room.

If a printer is attached to the console, a report may print each time you set,
change, or cancel a wake-up call.

To set or cancel a wake-up time while connected to the guest room:
1 - Press [SET WAKE-UP].

2 - Enter the time using four digits (hh:mm).

For example, for 6:30 enter 0630.
3 - Do one of the following:
4 Press [SET] to set the time as AM.

¢ Press [PM] to set the time as PM. ([PM] only appears if the system clock
is set to 12-hour format, and the hour entered is in the range 01 — 12.)

4 - Press [ExiT].

5 - Press Release.

To set or change a wake-up time when NOT connected to the guest room:
1 - Press Function.

2 - Press [GUEST RooMm].

3 - Dial the room number.

4 - Follow the steps from the previous procedure.
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Hotel/Motel Features

To cancel a wake-up call:
1 - Press Function.

2 - Press [GUEST RooMm].

3 - Dial the room number.

4 - Press [CLR WAKE-UP].

5 - Press [EXIT].

Some display sets can set their own timed reminder. The above procedures will also
clear or change a reminder already set by the user.

If the guest fails to answer the wake-up call, the system will ring the room twice
more at_ five-minute intervals. If a third wake-up call goes unanswered or reaches
a busy line, the system may generate a minor alarm at the console.

Setting Room Call Restrictions

70

You can restrict guests from placing local or long distance calls from their room
phones. The procedure you use to set call restrictions depends on whether the
hotel/motel is using a Property Management System.

If the hotel/motel is NOT using a Property Management System
1 - Press Function.
2 - Press [GUEST RooMm].
3 - Dial the room number.
4 - Press [STATUS].
5 - Do one of the following:
¢ Press [INTERNAL] to allow internal calls only.
¢ Press [LocaL] to allow internal and local calls.

¢ Press [LonG Dist] to allow internal, local, and long distance calls.




Blocking Room-to-Room Calls

If the hotel/motel is using a Property Management System

1 - Press Function.

2 - Press [GUEST RooMm].

3 - Dial the room number.
4 - Press [RESTRICT O/G].

5 - The phone is restricted from making outgoing trunk calls.

Blocking Room-to-Room Calls

You can use the Block key to bar calls between guest rooms. Only room phones
programmed with call blocking will be affected by this; ask your
communications department for further information.

To block room-to-room calls:

¢ Press Block.

Displaying or Clearing the Message Register

The message register is a record of all external calls placed from a guest room
telephone. You can display and clear a room’s message register while the
console is idle or while connected to the guest room.

To display or clear a room’s message register:

1 - Press Function.

2 - Press [GUEST Room].

3 - Dial the room number (not necessary if you are already connected
to the room).

4 - Press [CLR REGISTER].

If a printer is attached to the console, a report may print showing the contents
of the register before it was cleared.
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Hotel/Motel Features

Printing Reports

If a printer is connected to the console, you can request printed reports (audits)
of message registers, room status and automatic wake-ups.

Each audit has its own format and some are printed automatically. For example,
when a wake-up call is set, changed or canceled, the printer automatically
records it.

To print a report:

1 - Press Function.

2 - Press [GUEST RooMm].

3 - Press [AuUDITS].

4 - Select the report you want to print.

5 - Press [EXIT].
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About the Phone Book Editor

About the Phone Book Editor

You use the Phone Book Editor to make changes to the online telephone
directory.

Starting and Closing the Phone Book Editor

Before starting the Phone Book Editor, close the SUPERSET 7000 application.

To start the Phone Book Editor:
¢ Windows 3.1
Double-click the Bookutil icon in the SUPERSET 7000 Program Group

¢ Wwindows 95

Click the Start button on the task bar, point to Programs, SUPERSET 7000,
and then click Bookutil.

The Phone Book Editor window opens.
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To close the Phone Book Editor:
¢ Select Quit from the File menu or press ESC.

¢ Choose OK.
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Adding a New Entry

76

To add a new entry

1 - Choose New from the Edit menu or press F3.

2 - Type the extension number and then press Enter.
See the note below for further information.

3 - Type the person's name (last name first, followed by first name) and then
press Enter.

Enter names in a consistent manner to ensure consistent outcomes for
Phone Book searches.

4 - Type any additional information such as the person’s job title, department

name, location, etc.

To leave this field blank, press Enter.
5 - Press Enter.
6 - Do one of the following:

¢ Add another entry.

¢ Exit the new data entry mode by selecting Cancel.

The digits O - 9 plus * and # are valid entries_for extension numbers. You can also
enter the character P to insert pauses. The first P provides a two second pause and
enables Tone Signaling. Subsequent P’s provide additional two second pauses.
This is useful for accessing a voice mail system or other device controlled by DTMF
tones. Example: 1234PPP*5678. 1234 might be a voice mail extension number.
The first P enables Tone Signaling and provides a two second pause. The next two
P’s allow time for the voice mail system to answer (your system may require more
or less time). *5678 might be the password digits_for a specific mail box.




Deleting an Entry

Deleting an Entry

To delete a Phone Book entry:

1 - Select the entry you want to delete.

Use the scroll bar on the right or the t1 keys to move up or down through

the list.

You can also use the Find command to locate the entry. See Finding an
Entry below.

2 - Choose Delete from the Edit menu or press DEL.

3 - Select OK to delete the entry.

Finding an Entry

To find an entry in the Phone Book:
1 - Select Find from the Search menu or press F5.
2 - Type the name (or a portion of it), and then press Enter.

If you make a mistake, press ESC, and then re-enter the name.

3 - Press Enter to start the search.
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Changing an Existing Entry

1 - Select the entry you want to modify.

Use the 11 keys or the scroll bar beside the list of names to move up or down
through the list.

You can also use the Find command to locate the entry. See Finding an
Entry above.

2 - Select Modify from the Edit menu or press F4.
3 - Make the changes, and then press Enter.

To leave an entry unchanged, press Enter.

~

The modjified name or number must not match existing entries in the Phone Book.

Showing All Entries

Use this procedure following a search to display all entries in the Phone Book.

To show all entries in the Phone Book:

¢ Select Display All from the Search menu or press F6.

Use the 11 keys or the scroll bar beside the list of names to move up or down
through the list.

Printing the Phone Book

To print the Phone Book:
1 - Select Print from the File menu or press F2.

2 - Choose a printer, and then select OK.
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Telephone Directory

Telephone Directory

Name Number
POLICE:
FIRE:

HOSPITAL:

TROUBLE WITH
EXTENSION OR CONSOLE:
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Abbreviated Dialing List

Index Number ‘ Identity
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Class of Service/Restriction

Class of Service/Restriction

Each extension and trunk has a COS (Class of Service) and a COR (Class of
Restriction) that defines what the user of that extension or trunk can or cannot do.
The system can have up to 50 of each, although most companies use only a few.

To help you answer questions from users who may be having problems with the
system, you may want to record a brief description of the most common COSs
and CORs. For example, COS 1 might mean, “Allows only local calls,” and COR
10 might be, “No long distance calls after 6 PM.” Your communications
department can give you the required details.

CoS COS NAME ALLOWS...

COR COR NAME RESTRICTS...
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Console Screen Abbreviations
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Abb. ‘ Meaning Abb. Meaning ‘

ABBR Abbreviated FLEX Flexible

ACC Account FWD Forwarding

ANSR Answer IDENT Identity

ATT Attendant INT Intercept/Internal

BSY OUT | Busied Out LD Long Distance

CAN Cancel LDN Listed Directory Number

CBK Callback LOC Local

CDE Customer Data Entry MSG Message

CLR Clear MSW Message Waiting

COR Class of Restriction 0ocC Occupied

CoS Class of Service RCL Recall

W Call Waiting REG Register

DD/MM/YY | Day/month/year RLS Release

DISA Direct Inward System Access| |RM Room

DISTB Disturb RS Room Status or
Restricted Outgoing Calls

DND Do Not Disturb SER Serial

DST Destination VAC Vacant




System Messages _for SUPERSET Display Telephones

System Messages for SUPERSET Display Telephones

The following default messages can appear on all SUPERSET telephones
equipped with displays.

Message Message
Number

01 IN MEETING

02 OUT OF TOWN

03 ON VACATION

04 OUT ON A CALL

05 OUT TO LUNCH

06 GONE FOR THE DAY
07 GONE HOME

08 IN TOMORROW

09

10

11

12

13

14

15

Authorized SUPERSET users can change these messages and program seven
more for system-wide use. Keep a record of any changes and additions.

For instructions on setting these messages from the console, see Setting and
Clearing Advisory Messages on page 54.
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Glossary
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Busy-ourt

A feature allowing you to make a line or equipment indicate busy to an
incoming call. In effect, you take the line out of service until it can be repaired
or tested.

CAMP-ON

A feature allowing the system to queue calls directed to a busy extension, amd
then automatically connect the waiting party when the extension becomes free.
The busy extension hears a quick beep to indicate a call is waiting.

CENTRAL OFFICE (CO)

A facility housing the public telephone system and related equipment which
provides telephone service for customers in a geographical area.

CLAss OF RESTRICTION (COR)

When the system is programmed, the extensions and trunks are assigned to
different Classes of Restriction. A COR controls the outgoing call capabilites of
the extension or trunk. For example, an extension can be assigned a COR that
prevents it from making outside calls other than with the assistance of the
operator.

CLAss OF SERVICE (COS)

When your telephone system is programmed, the extensions are assigned to
different Classes of Service. Each class has access to a specific set of features.

DISA (DIRECT INWARD SYSTEM ACCESS)

A feature which allows callers to dial directly into the telephone system and use
its features and facilities.

HARDWARE

The physical components of the system.




Glossary

HunTt GROUP

Extensions assigned to a group with a common (pilot) telephone number as well
as their own personal extension numbers. An incoming call to a hunt group will
ring the first available extension.

LDN KEvs (LisTED DIRECTORY NUMBER)

Call-handling keys which allow you to select the sequence in which you answer
calls from outside the PABX.

PABX (PRIVATE AUTOMATIC BRANCH EXCHANGE)

Telephone switching system for private use by a company.

REcALL

A call which returns to the console after being transferred to a busy or
unanswered extension.

SOFTWARE

The routines, programs, and instructions required to run the system.

TRUNK

A trunk (outside line) is the external communications link between two
switching systems. This link can be between one or more telephone systems
(PABXs) or the PABX and Central Office equipment.
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Tone Demonstration

Your telephone system has several tones to inform you of the progress of your
call. You can use the Tone Demonstration feature to familiarize yourself with

the tones.

1 - Dial the Tone Demonstration access code

. (Ask your

communications department for the code.)

2 - Dial a two-digit tone code from the list below.

3 - Continue dialing codes to listen to other tones.

4 - Hang up when you are finished.

Code Tone Name

Meaning

11 Dial Tone Heard when you lift the handset.

12 Transfer Tone Heard at an extension when the user places a call
on hold to consult with another party or to
transfer the call.

13 Busy Tone Heard when the number you dialed is busy.

14 Special Busy Tone Heard when the extension you called has Do Not
Disturb activated.

15 Ringback Tone Heard when the destination you dialed is ringing.

16 Not used

17 Reorder Tone Heard when a feature is not available to you or

(Error Tone) not in your Class of Service, or when you dial an
invalid number.

18 Conference Heard when a new person joins a conference call.

19 Call Waiting Tone Heard during a conversation when you have an

(Camp-on) internal call waiting to be answered.
20 Intrusion Tone Heard by all parties in a conversation when
(Override) someone overrides (intrudes into) a call.
21 Interrupted Heard when you lift the handset at an extension
Dial Tone that has Do Not Disturb or Call-Forward Always
activated.
22 Not used
23 Waiting on Hold Heard by a caller on hold and during camp-on.
Tone
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Code Tone Name

Tone Demonstration

Meaning

24 Paging Tone Heard when you are connected to the loudspeaker
paging equipment.

25 Not used

26 Trunk Camp-on Heard during a conversation when you have an

Double Beep Tone external call waiting.
27 ARS Expensive If your system has Automatic Route Selection
Warning Tone (ARS), you will hear this tone when no
inexpensive routes are available for your long-
distance call. The tone is a warning that your call
is taking an expensive route.

28 ARS Dial Tone If your system has Automatic Route Selection
(ARS), you will hear this tone after you dial the
trunk access code.

29 Override Warning Heard by all parties in a conversation when

Tone someone overrides (intrudes into) the call.

30 Privacy Release Tone | Heard when privacy is released on a SUPERSET
telephone and the new member joins the call.

31 Auto Answer Call Heard by a user that has a SUPERSET in Auto-

End Tone Answer mode when the calling party hangs up.

32 Attendant Error Heard by the Attendant, when attempting to do

Tone something that is not allowed, such as trying to
connect two devices that are not allowed to be
connected.

33 Ringer Pitch Dialed at SUPERSET telephones to hear

Adjustment

adjustments to ringer pitch.
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Trunk Identification

Trunk Number Identity
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Index

Index

Numerics
911 call alarms, viewing and clearing, 40

A

Abbreviated Dialing numbers, entering and
viewing, 44
abbreviations, console screen, 84
accessing specific trunks, 61
Advisory Messages
calling extensions with Advisory Messages, 22
list of Advisory Messages, 85
setting and clearing on extensions, 54
alarms, viewing and clearing, 39
All Set Page, 28
answering calls
multiple calls waiting, 19
new call indication, 19
new calls, 18
when Night Service enabled, 33
Application area, console screen, 7
applications, accessing, 47
audits (printouts) for guest rooms, 72
Auto Answer, using, 14

bell, See ringer
blocking calls between guest rooms, 71
Bookutil, 75
busy

recalls, 26

transferring to busy extensions, 21
busy out

definition, 86

extensions, 55

trunks, 62

C

C/W indicator, 18
cadence, ringer, 11
Call Block, 71
call forwarding
cancel on all extensions, 42
setting and canceling on individual extensions,
51
call restrictions for guest rooms, 70
call splitting, 25
Callback
about, 21
canceling on all extensions, 42
leaving at an extension, 21
Call-handling keys, 8
call-handling keys, 17
Camp-on, definition, 86
canceling
Advisory Messages, 54
all Call Forwarding, 42
all callbacks, 42
Call Forwarding on individual extensions, 51
Do Not Disturb on individual extensions, 28, 52
Message Waiting on individual extensions, 29,
53
CAS, See Centralized Attendant Service
CDE (Customer Data Entry), 47
Central Office, definition, 86
Centralized Attendant Service, 34
Class of Restriction, definition, 86
Class of Service, definition, 86
closing SUPERSET 7000, 10
Command and Response area, console screen, 7
conferences, setting up, 25
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Index

console
adjusting, 11
changing language, 13
components, 7
directory number, displaying, 46
intercepts, 27
language, changing, 13
lockout, 13
monitor, 7
Night/Day Service, switching, 12
ringer, adjusting volume and cadence, 11
ringer, turning on/off, 12
screen abbreviations, 84

console keyboard, about, 8

cursor control keys, 8

Customer Data Entry, 47

D

date, setting, 41
Day Service, switching, 12
Dial pad keys, about, 8
dialing mistakes, correcting, 20
Directed Call Pickup, 33
directory number, display console, 46
DISA
access codes, changing, 43
definition, 86
DND
overriding, 21, 29

setting and canceling on an extension, 28, 52

Do Not Disturb, See DND

emergency 911 call alarms, viewing and clearing,

40
exiting SUPERSET 7000, 10
extending calls, See transferring calls

F

flashing on trunks, 32
Flexible Night Answer, 45
French, console language, 13

G

Group Paging, 28
Guest Room

H

blocking room-to-room calls, 71

calling restrictions, 70

changing occupancy and condition status, 68
display and changing room data, 65
displaying and clearing Message Register, 71
listing rooms by occupancy and condition
status, 67

printing status, 72

wake-up calls, 69

handset volume, adjusting, 12
hardware, definition, 86
headset volume, adjusting, 12
Hold

pickup, 24

placing calls on, 23

recall, 24

retrieving calls on hold, 23
stacked, 24

Hotel/Motel features, See Guest Room
Hunt Group, definition, 87

identity

console, 46
system, 46

installing SUPERSET 7000, 4
intercepts to console, 27

K

keyboard, console, 8

L

language, changing on console, 13

last number redial, 31

LDN (Listed Directory Number), definition, 87
lockout console, 13
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M

main screen, returning to, 11
making calls, 22
Message Register
displaying and clearing, 71
printing, 72
Message Waiting
reading messages, 53
setting and canceling on an extension, 29, 53
minimum PC requirements to run SUPERSET 7000,
3
misdialed numbers, correcting, 20
monitor
about the console, 7
multiple console operation, 34

new call indication, 19

night answering points, setting up, 45

Night Service
answering calls when Night Service enabled, 33
setting up answering points, 45
switching, 12

no answer recalls, 26

(o)

outgoing calls, allowing/restricting from guest
rooms, 70
override busy and Do Not Disturb, 29

P
PABX, definition, 87
paging, 27

PBX programming requirements, 4
PC requirements to run SUPERSET 7000, 3
Phone Book Editor
about, 75
adding entries, 76
deleting entires, 77
editing entries, 78
finding entries, 77
opening and closing, 75
printing, 78
showing all entries, 78
Phone Book, using, 30
picking up calls on hold at the console, 24
placing calls, 22
printing guest room reports, 72
printing, Phone Book, 78

Index

recalls
answering, 26
definition, 87
redialing, last number redial, 31
restricting calls from guest rooms, 70
returning to main screen, 11
ringer
adjusting volume and cadence, 11
turning on/off, 12
room status
changing, 68
listing by occupancy and condition status, 67
room-to-room calls, restricting, 70

S

screen, abbreviations, 84
Serial Call, 31
service
switching to Day/Night, 12
taking extensions in or out, 55
taking trunks in or out, 62
Set Paging, 28
Softkeys, about, 8
software version, displaying, 46
software, definition, 87
sound card, 3
Spanish, console language, 13
splitting conferences, 25
stacked hold, 24
starting SUPERSET 7000, 10
Status area, console screen, 7
SUPERSET 7000
installing, 4
starting and closing, 10
SUPERSET telephones
calling SUPERSETSs with Advisory Messages, 22
list of Advisory Messages, 85
setting and clearing Advisory Messages, 54
system
alarms, viewing and clearing, 39
identification, displaying and changing, 46
software version, displaying, 46
time and date, setting, 41
system requirements to run SUPERSET 7000, 3
System Speed Calling numbers, See Abbreviated
Dialing numbers
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T v
TALK TO card, 3, 4 voice mail, affect on console operations, 35
time, setting, 41
tone demonstration, 88 W
Tone Signaling wake-up calls
enabling/disabling tones, 32 printing, 72
voice mail, 35 setting and canceling, 69
transferring calls, 20, 34
trunks
accessing specific 61
busy out, 62

definition, 87

flashing, 32

viewing status of individual trunks, 59
viewing status of trunk groups, 60
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